
MalTec Stacja Pogody 
bezprzewodowa Daily2000M

Instrukcja obsługi



Przed użyciem prosimy o dokładne zapoznanie się z niniejszą instrukcją 
i zachowanie jej na przyszłość.

FUNKCJE

 Prognoza  pogody.  (słonecznie,  częściowo  pochmurno,  pochmurno,  lekki  deszcz, 
silny deszcz)

 Automatyczna kalibracja czasu. (DCF)
 Wyświetlanie czasu/miesiąca/dnia/tygodnia w formacie 12/24 godzin.
 Budzik i funkcja drzemki.
 Temperatura i wilgotność wewnątrz i na zewnątrz, przełączane od °C do °F. (Stacja 

pogodowa  może  być  jednocześnie  połączona  z  3  czujnikami  temperatury  i 
wilgotności.)

 Rejestracja temperatury i wilgotności maks./min.
 Wyświetlanie trendów zmian temperatury i wilgotności wewnątrz i na zewnątrz.
 Wskaźnik komfortu wilgotności w pomieszczeniu.
 Ciśnienie atmosferyczne, faza księżyca.
 Funkcja podświetlenia z 3 poziomami jasności. (Zasilanie prądem stałym jest ważne)
 Można przełączać 7 języków tygodnia. (EN → DE → FR → SP → IT → DU → DA)
 Zasilacz:

Stacja pogodowa: Adapter lub 2 baterie LR6 AAA;
Czujnik: 2 × baterie LR6 AAA;

 Odległość połączenia:
Stacja  pogodowa oraz  czujnik  termometru  i  higrometru:  100M (bez  zakłóceń/bez 
przeszkód)

WYGLĄD STACJI POGODOWEJ
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1. Dane dotyczące ciśnienia powietrza 8. Faza Księżyca

2. Prognoza pogody 9. Temperatura wewnętrzna

3. Wyświetlanie czasu 10. Wilgotność w pomieszczeniu

4. Ikona alarmu 11. Poziom komfortu

5. Sygnał radiowy DCF 12. Temperatura czujnika

6. Miesiąc/data 13. Czujnik wilgotności

7. Tydzień 14. Wskaźnik niskiego poziomu baterii

Odp.: Gniazdo zasilania
B: Przyciski obsługi stacji pogodowej:
TRYB:  Pojedyncze naciśnięcie  powoduje zmianę jednostki  temperatury  °C/°F;  Naciśnij 
długo, aby przejść do trybu ustawień, kolejność ustawień: 12/24 Format → Strefa czasowa 
→ Godzina → Minuta → Rok → Miesiąc → Data → Format daty (kolejność miesiąca i 
daty) → Tydzień Język → Wyjdź.
ALARM: Pojedyncze naciśnięcie powoduje sprawdzenie godziny alarmu; Naciśnij długo, 
aby wejść do ustawień alarmu.
W GÓRĘ:  Jedno naciśnięcie, aby sprawdzić dane dotyczące maksymalnej i minimalnej 
temperatury i wilgotności; Naciśnij długo, aby wyczyścić dane dotyczące maksymalnej i 
minimalnej temperatury oraz wilgotności.
W DÓŁ: Pojedyncze naciśnięcie powoduje włączenie ALARM1 i ALARM2; Naciśnij długo, 
aby WYŁĄCZYĆ ALARM1 i ALARM2.
RCC:  Pojedyncze naciśnięcie powoduje zmianę jednostki ciśnienia powietrza inHg/hPa; 
Długie  naciśnięcie  powoduje wymuszone otwarcie  lub wyłączenie  odbioru RCC. (RCC 
oznacza, że czas zostanie automatycznie skalibrowany po odebraniu sygnału.)
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CH:  Pojedyncze  naciśnięcie  powoduje  przełączenie  kanału  odbioru  czujnika  stacji 
pogodowej;  Długie  naciśnięcie  powoduje  wyczyszczenie  kanału  odbiorczego nadajnika 
stacji pogodowej i ponowne wejście w tryb odbioru czujnika.

:  Zasilanie  bateryjne,  jedno  naciśnięcie  włącza  podświetlenie  na  10  sekund; 
Zasilany  przez  adapter,  jedno  naciśnięcie  pozwala  dostosować  jasność  podświetlenia, 
sekwencja to L3 → L2 → L1 → WYŁ. Gdy włączy się alarm, naciśnij jednokrotnie, aby 
przejść do trybu drzemki.

WYGLĄD CZUJNIKA

1. Temperatura zewnętrzna 6. Przycisk kanału czujnika

2. Kanał czujnika 7. Przycisk jednostki temperatury czujnika

3. Sygnał bezprzewodowy czujnika 8. Sygnał czujnika Przycisk ręcznej skrzyni 
biegów

4. Przypomnienie o niskim poziomie 
energii elektrycznej

9. Komora baterii

5. Wilgotność na zewnątrz

Czujnik można stosować wewnątrz i na zewnątrz. Należy jednak chronić je przed wilgocią, 
wodą, deszczem itp.
UWAGA:  Kanał stacji pogodowej musi być zgodny z kanałem czujnika, dane dotyczące 
temperatury i wilgotności z czujnika mogą być wyświetlane na stacji pogodowej.

SZYBKI MONTAŻ

 Podłącz  jeden  koniec  zasilacza  do  gniazdka  elektrycznego,  a  następnie  podłącz 
drugi koniec do stacji pogodowej. (Opcjonalnie: włóż 2 baterie AAA jako zapasowe).

 Wyświetlacz LCD wyświetla wszystkie elementy przez 2 sekundy, a następnie po 
usłyszeniu  sygnału  dźwiękowego  przełącza  się  do  standardowego  trybu 
wyświetlania,  aby  wyświetlić  wartości  temperatury,  wilgotności  i  ciśnienia 
atmosferycznego w pomieszczeniu.

 Włóż 2 baterie AAA do termometru zewnętrznego i czujnika higrometru, a następnie 
umieść je na zewnątrz.
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 Stacja  pogodowa  automatycznie  przechodzi  na  3  minuty  w  tryb  odbioru 
bezprzewodowego i automatycznie wyświetla temperaturę i wilgotność zewnętrzną. 
Jeśli czujnik termometru i higrometru nie otrzyma danych w ciągu 3 minut od stacji 
pogodowej,  stacja  pogodowa nie  odbierze  danych automatycznie,  należy  ręcznie 
obsługiwać i odbierać.

INSTRUKCJA ZEGARA STEROWANEGO RADIEM (RCC)

UWAGA:  W trakcie odbierania sygnału przez RCC, z wyjątkiem możliwości  włączenia 
podświetlenia,  inne funkcje nie mogą być obsługiwane.  Jeśli  chcesz obsługiwać stację 
pogodową, naciśnij i przytrzymaj przycisk CH, aby wyjść z trybu odbioru RCC.
 Gdy stacja pogodowa jest  włączona na 3 minuty,  automatycznie przejdzie w tryb 

długiego odbioru RCC, a trójkątny symbol wieży RCC „  ” wyświetli  się i zacznie 
migać; jeśli odebrany zostanie sygnał radiowy, trójkątny symbol wieży RCC „ ” nie 
miga,  a  symbol  fali  sygnału  RCC „  ”  wyświetla  się  i  miga;  jeśli  sygnał  radiowy 
zostanie  przerwany  podczas  odbioru,  symbol  fali  sygnału  „  ”  RCC  nie  będzie 
wyświetlany,  a  symbol  trójkątnej  wieży  „  ”  RCC  zostanie  przekształcony  w 
wyświetlacz i zacznie migać.

 Długi czas odbioru RCC wynosi 7 minut. Jeżeli odbiór RCC przebiegnie pomyślnie w 
ciągu 7 minut, czas wyświetlany przez stację pogodową zostanie przeliczony na czas 
odebrany,  a  na  ekranie  pojawi  się  symbol  RCC „  ”;  Jeśli  w  ciągu 7  minut  nie 
zostanie  odebrany  żaden  sygnał,  automatycznie  zakończy  odbiór  RCC  i  będzie 
kontynuował podróż w pierwotnym czasie.

 W trybie standardowym naciśnij  długo przycisk  CH  ,  aby wymusić wejście w tryb 
odbioru RCC i wykonaj odbiór RCC w sposób opisany powyżej.

 Automatycznie  odbieraj  RCC:  Niezależnie  od  tego,  czy  sygnał  RCC  zostanie 
odebrany, czy nie, automatycznie przejdzie on do odbioru RCC o 1:00, 2:00, 3:00, 
4:00 i 5:00 każdego ranka; W przypadku udanego przyjęcia o godzinie 3:00, kolejne 
godziny 4:00 i 5:00 nie zostaną otwarte dla recepcji; niezależnie od tego, czy odbiór 
się  powiódł,  czy  nie,  RCC  ponownie  wejdzie  w  cykl  o  godzinie  1:00  w  nocy 
następnego dnia w trybie odbioru.

 W trybie  odbioru  RCC nie  jest  wykonywana  detekcja  temperatury,  temperatury  i 
ciśnienia atmosferycznego.

 Stacja  pogodowa  powinna  znajdować  się  w  jak  największej  odległości  od 
stosunkowo  dużych  urządzeń  typu:  lodówka,  klimatyzacja,  kuchenka  indukcyjna, 
komputer.

RĘCZNE USTAWIENIE CZASU

 Naciśnij i przytrzymaj przycisk MODE, aby przejść do trybu ustawiania czasu.
 Po  wejściu  w  tryb  ustawiania  czasu,  każdorazowe  naciśnięcie  przycisku  MODE 

powoduje potwierdzenie i przejście do kolejnego elementu ustawień.
 Sekwencja ustawień: 12/24 Format → Strefa czasowa → Godzina → Minuta → Rok 

→ Miesiąc → Data → Format daty (kolejność miesiąca i daty) → Tydzień Język → 
Wyjdź.

 Za każdym razem,  gdy  naciśniesz  przycisk  „W GÓRĘ”  lub  „W DÓŁ”,  ustawiona 
pozycja zostanie dodana lub odjęta o jeden krok.

 Naciśnij i przytrzymaj przyciski „W GÓRĘ” lub „W DÓŁ” przez ponad 3 sekundy, aby 
szybko zwiększyć lub zmniejszyć, 8 kroków na sekundę.

 20 sekund bez użycia jakichkolwiek przycisków, dane ustawień zostaną zapisane i 
wyjdzie z trybu ustawień.
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USTAWIENIE ALARMU

 Pojedyncze  naciśnięcie  przycisku  ALARM  pozwala  sprawdzić  czas  ALARM1  i 
ALARM2.

 Naciśnij i przytrzymaj przycisk ALARM , aby wejść w tryb ustawiania alarmu.
 Po wejściu w tryb ustawiania alarmu, każdorazowe naciśnięcie przycisku  ALARM 

powoduje potwierdzenie i przejście do kolejnego elementu ustawień.
 Kolejność ustawień: Godzina → Minuta → Wyjdź.
 Podczas procesu ustawiania naciśnij raz przycisk „  W GÓRĘ ” lub „  W DÓŁ ”, aby 

zwiększyć lub zmniejszyć czas. Naciśnij i przytrzymaj przez 3 sekundy, aby szybko 
ustawić godzinę.

 Po zakończeniu  ustawiania  alarmu,  alarm jest  domyślnie  wyłączony;  Naciśnij  raz 
przycisk W DÓŁ, aby włączyć ALARM 1, naciśnij ponownie, aby włączyć ALARM 2, 
naciśnij  ponownie, aby włączyć jednocześnie ALARM 1 i ALARM 2; po włączeniu 

alarmu na ekranie pojawi się symbol „ ”;  Naciśnij długo przycisk W DÓŁ ,  aby 

wyłączyć jednocześnie ALARM 1 i ALARM 2, symbol alarmu „ ” zniknie.
 Brak działania przez 20 sekund spowoduje zapisanie istniejących ustawień i powrót 

do wyświetlania czasu lub pojedyncze naciśnięcie przycisku  MODE  ,  aby wyjść i 
powrócić do wyświetlania czasu.

 Dźwięk alarmu jest  podzielony na 4 segmenty,  1  ~ 10 sekund „Bi”  raz;  10 ~ 20 
sekund „Bi Bi” dwa sygnały dźwiękowe; 20~30 sekund „Bi Bi Bi Bi” cztery sygnały 
dźwiękowe; Długi sygnał dźwiękowy po 30 sekundach.

 Gdy włączy się alarm, miga sygnał alarmu „ ”; Czas alarmu wynosi 2 minuty.

 Kiedy budzik zadzwoni, naciśnij  dowolny przycisk z wyjątkiem  przycisku „ ”, 
aby anulować alarm.

FUNKCJA DRZEMKI

 Kiedy budzik zadzwoni,  naciśnij  przycisk „  ”,  alarm zostanie opóźniony o 5 

minut, a symbole drzemki i alarmu „ ” i „ ” zaczną migać na ekranie.

 W stanie „Drzemka” naciśnij dowolny przycisk z wyjątkiem przycisku „ ”, aby 
anulować „Drzemka”.

OPIS WYŚWIETLACZA TEMPERATURY

TEMPERATURA 
WEWNĘTRZNA

Zasięg wykrywania -9,9 °C~5°C (14,0°F~122°F)

Rozdzielczość wyświetlacza 0,1 °C (°F)

TEMPERATURA 
ZEWNĘTRZNA

Zasięg wykrywania -40 °C~60°C (-40°F~140°F)

Rozdzielczość wyświetlacza 0,1 °C (°F)

 Dokładność temperatury: 0 ~ 40°C: ±1°C, inny zakres: ±2°C.
 Domyślna  jednostka  temperatury:  °C.  (Jeśli  chcesz  zmienić  jednostkę,  naciśnij 

przycisk MODE na stacji pogodowej, aby ją zmienić.)
 Gdy wykryta temperatura w pomieszczeniu jest niższa niż -9,9°C (14,0°F), wartość 

wyświetlana w kolumnie TEMPERATURA WEWNĘTRZNA będzie wyświetlana jako 
„LL.L°C  (°F)”,  a  gdy  temperatura  będzie  wyższa  niż  50  °C  (122°F),  będzie 
wyświetlane jako „HH.H°C (°F)”.

 Gdy temperatura zewnętrzna jest niższa niż -40°C (-40°F), wartość wyświetlana w 
kolumnie TEMPERATURA ZEWNĘTRZNA będzie wyświetlana jako „LL.L°C (°F)”, a 
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gdy  temperatura  będzie  wyższa  niż  60°C  (140°F),  będzie  ona  wyświetlana  jako 
„HH.H°C (°F)”.

OPIS WYŚWIETLACZA WILGOTNOŚCI

WILGOTNOŚĆ W 
POMIESZCZENIU

Zasięg wykrywania
20% wilgotności względnej ~ 
95% wilgotności względnej

Rozdzielczość wyświetlacza 1% wilgotności względnej

WILGOTNOŚĆ NA 
ZEWNĄTRZ

Zasięg wykrywania
20% wilgotności względnej ~ 
95% wilgotności względnej

Rozdzielczość wyświetlacza 1% wilgotności względnej

 Dokładność wilgotności: 40% RH ~ 80% RH: ± 5% RH, inny zakres: ± 8% RH.
 Jeśli wykryta wilgotność w pomieszczeniu lub na zewnątrz jest niższa niż 20% RH, 

nadal będzie wyświetlana jako „20% RH”, a jeśli będzie wyższa niż 95% RH, będzie 
nadal wyświetlana jako „95% RH”.

MAKSYMALNA/MIN TEMPERATURA I WILGOTNOŚĆ

 Naciśnij raz przycisk W GÓRĘ, aby wyświetlić MAKSYMALNY zapis temperatury i 
wilgotności,  naciśnij  ponownie,  aby  wyświetlić  MINIMALNY  zapis  temperatury  i 
wilgotności, naciśnij ponownie, aby wyjść.

 Naciśnij  i  przytrzymaj  przycisk  UP,  aby  wyczyścić  zapis  MAX/MIN  temperatury  i 
wilgotności;  temperatura wyświetli  „--.-”  przez 3 sekundy,  a następnie powróci  do 
wyświetlania aktualnej temperatury.

 Po  wyczyszczeniu  zapisu  rozpocznij  rejestrację  nowej  temperatury  i  wilgotności 
MAX/MIN.

 MAX/MIN rejestruje najwyższą i  najniższą temperaturę i  wilgotność w ciągu dnia, 
która jest automatycznie kasowana i ponownie rejestrowana każdego dnia o godzinie 
0:00.

 Jeśli  na  wyświetlaczu pojawi  się  MAX lub MIN,  a  przez 20 sekund nie  zostanie 
wykonana żadna operacja, nastąpi powrót do wyświetlania aktualnej temperatury.

OPIS TRENDÓW TEMPERATURY I WILGOTNOŚCI

 Gdy  temperatura  będzie  nadal  rosła  o  1°C  (1,8°F)  lub  więcej,  wyświetlony 
zostanie symbol trendu temperatury „ ”.

 Jeśli temperatura nie zmieni się o więcej niż 1°C (1,8°F) w ciągu 1 godziny,  
wyświetlony zostanie symbol trendu stopni „ ”.

 Gdy temperatura będzie  nadal  spadać o 1°C (1,8°F)  lub więcej,  wyświetlony 
zostanie symbol trendu temperatury „ ”.

 Gdy wilgotność będzie nadal rosnąć o 5% RH i  więcej,  wyświetlony zostanie 
symbol trendu temperatury „ ”.

 Jeśli  wilgotność  nie  zmieni  się  o  więcej  niż  5%  RH  w  ciągu  1  godziny,  
wyświetlony zostanie symbol trendu stopni „ ”.

 Gdy  wilgotność  w  dalszym ciągu  spadnie  o  5% RH lub  więcej,  wyświetlony 
zostanie symbol trendu temperatury „ ”.

RODZAJE WYŚWIETLANEJ POGODY

Prognoza pogody polega na przewidywaniu pogody na najbliższe 12 godzin na podstawie 
zmian ciśnienia powietrza w przeszłości i rzeczywistości; Oblicz i przewiduj co ostatnie 6 
godzin; 5 typów prognoz pogody, jak pokazano poniżej
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Słoneczny

Częściowe zachmurzenie

Pochmurny

Lekki deszcz

Ulewa

INSTRUKCJA FAZ KSIĘŻYCA

Poziom fazy księżyca jest wyświetlany w kolumnie FAZA KSIĘŻYCA. Poziom faz księżyca 
jest podzielony na 8 poziomów, jak pokazano na poniższym rysunku:

Księżyc w nowiu → Półksiężyc → Księżyc w pierwszej kwadrze → Ubywający Księżyc 
Garbaty → Księżyc w pełni → Ubywający Księżyc Garbaty → Księżyc w ostatniej kwadrze 
→ Ubywający Księżyc

INSTRUKCJA CIŚNIENIA ATMOSFERYCZNEGO

Przełącz  jednostkę  ciśnienia  powietrza  w  tryb  ustawień.  Ciśnienie  atmosferyczne  jest 
aktualizowane i testowane co 1 godzinę, a wartość ciśnienia powietrza jest rejestrowana w 
tym samym czasie. (Domyślna jednostka ciśnienia powietrza: hPa; jeśli zajdzie potrzeba 
zmiany jednostki, naciśnij przycisk Przycisk RCC stacji pogodowej.)

CIŚNIENIE 
ATMOSFERYCZNE

ZASIĘG WYKRYWANIA
600 hPa/mb ~ 1100 hPa/mb
(17,72 cala Hg ~ 32,50 cala 

Hg)

ROZDZIELCZOŚĆ 
WYŚWIETLACZA

1 hPa/mb i 0,01 cala Hg

WSKAŹNIK NISKIEGO AKUMULATORA

 Gdy  napięcie  robocze  stacji  pogodowej  spadnie  poniżej  2,5  V,  wyświetli  się 
symbol słabej baterii „ ”, wskazując, że należy wymienić baterię.

 Gdy  napięcie  robocze  nadajnika  będzie  niższe  niż  2,5  V,  zabrzmi  sygnał 
ostrzegawczy  o  niskim  stanie  baterii,  a  w  odpowiedniej  kolumnie  kanału 
wyświetli się symbol słabej baterii „ ”.
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USTAWIENIE PODŚWIETLENIA

 Gdy  stacja  pogodowa  jest  zasilana  z  baterii,  w  dowolnym  trybie  naciśnij 
jednokrotnie przycisk „ ”, aby włączyć podświetlenie na 10 s. Podświetlenie wyłączy 

się automatycznie, jeśli w trakcie świecenia nie zostanie naciśnięty przycisk „ ”.
 Gdy  stacja  pogodowa  jest  zasilana  prądem  stałym  (po  zasileniu  prądem  stałym 

obwód zostanie automatycznie rozłączony, jeśli produkt jest wyposażony w baterię), 

podświetlenie  pozostanie  włączone,  naciśnij  przycisk  „  ”,  aby  przełączyć 
jasność stacji pogodowej podświetlenie. Jasność jest podzielona na 3 stopnie: L3 → 
L2 → L1 → Off.

UWAGA:  Gdy  stacja  pogodowa  jest  zasilana  prądem  stałym,  jeśli  automatycznie  lub 
ręcznie wejdzie w odbiór RCC, podświetlenie zostanie automatycznie wyłączone. Można 

nacisnąć przycisk „ ”, aby włączyć podświetlenie na 10 sekund (tryb najjaśniejszy).

KANAŁ STACJI POGODOWEJ

 Jeśli  stacja  pogodowa  odbierze  sygnał  radiowy  z  czujnika  zewnętrznego, 
automatycznie  wyświetli  odpowiedni  kanał.  Można  jednak  także  ręcznie  ustawić 
wyświetlanie różnych kanałów radiowych.

 Naciśnij  kilkakrotnie  przycisk  CH  ,  aby  przełączać  pomiędzy  wyświetlaczami  

(pokaż tylko kanał 1), (pokaż tylko kanał 2), (pokaż tylko kanał 3) i (przewijaj 
wszystkie kanały w pętli).

 Jeśli czujnik nie połączy się automatycznie ze stacją pogodową, spróbuj połączyć się 
ręcznie; Naciśnij i przytrzymaj przycisk CH , aby wyczyścić kanał odbiorczy nadajnika 
stacji pogodowej i ponownie wejść w tryb odbioru.

KANAŁ CZUJNIKA

 Otwórz komorę baterii z tyłu urządzenia, zdejmując pokrywę komory baterii.
 Wybierz kanał radiowy, przesuwając przełącznik wyboru kanałów CH na CH 1, CH 2 

lub CH 3.
 Naciśnij  i  przytrzymaj  przycisk  stacji  pogodowej  CH  ,  aż  na  wyświetlaczu 

zewnętrznym zacznie migać sygnał odbioru „ ”.
 Naciśnij  przycisk  TX  ,  aby  ręcznie  zainicjować  sygnał  radiowy  czujnika 

zewnętrznego.  Jeśli  odbiór  się  powiedzie,  temperatura  i  wilgotność  będą  teraz 
wyświetlane na wyświetlaczu zewnętrznym nowego kanału radiowego.

CZĘSTO ZADAWANE PYTANIA

Pytanie 1. Dlaczego automatyczna kalibracja czasu jest nieprawidłowa?
A1: Zegar atomowy DCF:
Sygnał zegara to DCF, sygnał odbierany przez DCF to czas niemiecki. Jeśli Twój czas 
lokalny jest taki sam jak czas niemiecki, nie musisz dostosowywać STREFY. Jeśli Twój 
czas  lokalny  jest  opóźniony  o  1  godzinę  w  stosunku  do  czasu  niemieckiego,  musisz 
ustawić czas STREFY na -01; jeśli Twój czas lokalny jest 1 godzinę do przodu w stosunku 
do czasu niemieckiego, musisz ustawić czas STREFY na 01. Na przykład czas w Wielkiej 
Brytanii  jest 1 godzinę opóźniony w stosunku do czasu niemieckiego, STREFĘ należy 
ustawić  na  -01.  (Jeśli  chcesz  zmienić  STREFĘ  czasową,  użyj  przycisku  SET  stacji 
pogodowej, aby ją zmienić)

Pytanie  2.  Dlaczego  stacja  pogodowa  nie  wyświetla  od  razu  danych  z  czujnika 
zewnętrznego po włączeniu zasilania?
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A2:  Czujnik  termometru  i  higrometru  ma  cykl  transmisji  sygnału,  cykl  transmisji  jest 
następujący: Czujnik: CH1: 50 sekund; CH2: 63 sekundy; CH3: 76 sekund.

P3. Dlaczego podświetlenie nagle gaśnie i nie można obsługiwać stacji pogodowej?
A3:  Podczas  odbioru  miga  symbol  trójkąta  „  ”,  nie  można wykonać żadnych innych 
operacji. Zakończenie odbioru zajmuje około 4-8 minut. Jeśli zajdzie potrzeba wykonania 
operacji, naciśnij i przytrzymaj przycisk CH, aby zakończyć odbiór sygnału, symbol trójkąta 
nie miga już, możesz teraz obsługiwać zegar.

P4. Dlaczego dane z czujnika zewnętrznego nie są wyświetlane na ekranie stacji 
pogodowej?
A4: Najpierw sprawdź, czy kanał czujnika temperatury i wilgotności jest taki sam jak kanał 
stacji pogodowej. Na przykład kanał stacji pogodowej to 1, a kanał czujnika musi mieć 
wartość 1; Po drugie, sprawdź, czy odległość między stacją pogodową a nadajnikiem jest 
większa niż nasz zakres odległości.
Uwaga: Po włączeniu stacja pogodowa włączy 3-minutowy tryb odbioru. Jeśli termometr i 
czujnik  higrometru nie zostaną odebrane w ciągu 3 minut  od stacji  pogodowej,  stacja 
pogodowa nie odbierze automatycznie danych, należy ręcznie je obsługiwać i odbierać. 
(Konkretne metody działania można znaleźć w A5 )

P5.Co zrobić jeśli  czujnik termometru i  higrometru nie jest  podłączony do stacji 
pogodowej?
A5: Naciśnij długo przycisk CH na stacji pogodowej przez ponad 3 sekundy, ikona odbioru 
temperatury i  wilgotności  „  ”  będzie migać na stacji  pogodowej,  a następnie otwórz 
pokrywę  baterii  czujnika  i  naciśnij  przycisk  TX  ,  aby  ręcznie  podłączenie  (przed 
przystąpieniem do pracy zapoznaj się z A3) lub ponownie włącz stację pogodową.
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Utylizacja sprzętu elektrycznego

Symbol przekreślonego pojemnika na śmieci na kółkach umieszczony na 
produktach informuje, że zużyty sprzęt elektryczny i elektroniczny (zwany 
dalej  także  „zużytym  sprzętem”  lub  „elektroodpadem”)  nie  może  być 
wyrzucany wraz z  odpadami  komunalnymi.  Wrzucając  elektroodpady do 
kontenera  stwarzasz  zagrożenie  dla  środowiska.  Używany  sprzęt  może 
zawierać  substancje  (np.  ołów,  kadm,  chrom,  brom,  rtęć,  freon) 

niebezpieczne dla zdrowia i życia ludzi oraz dla środowiska. Sortując i przekazując zużyty 
sprzęt  do  przetworzenia,  odzysku,  recyklingu  i  utylizacji,  chronisz  środowisko  przed 
zanieczyszczeniami  i  skażeniami,  przyczyniasz  się  do  ograniczenia  zużycia  zasobów 
naturalnych oraz obniżenia kosztów produkcji nowego sprzętu.

Deklaracja CE

Malis B. Machoński sp. k. Oświadcza, że urządzenie MalTec Stacja Pogody 
bezprzewodowa Daily2000M spełnia wszystkie wymagania Dyrektywy LVD 2014/35/UE, 
WE 2014/30/UE oraz spełnia następujące normy:
EN IEC 62368-1:2020+A11:2020
EN 62479:2010 EN 50663:2017
EN 301 489-1 V2.2.3 (2019-11)
EN 301 489-3 V2.3.2 (2023-01)

EN 55032:2015+A11:2020
EN 55035:2017+A11:2020
EN 61000-3-3:2013+A1:2019
EN 300 220-1 V3.1.1 (2017-02)
EN 300 220-2 V3.2.1 (2018-06)

Importer:

Malis B. Machoński sp. k.
ul. Zbożowa 2E, Wysogotowo
62-081 Przeźmierowo
www.maltec.pl
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Daily2000M Wireless Weather 
Station

Instruction Manual



Please read this booklet thoroughly before using and save it for future 
reference.

FUNCTIONS

 Weather forecast. (Sunny, partly cloudy, cloudy, light rain, heavy rain)
 Automatic time calibration. (DCF)
 12/24 hour time/month/day/week display.
 Alarm clock and snooze function.
 Indoor&outdoor temperature and humidity, °C to °F switchable. (Weather station can 

be matched with 3 temperature&humidity sensors at the same time.)
 Temperature and humidity max/min record.
 Indoor&outdoor temperature and humidity change trend display.
 Indoor humidity comfort indicator.
 Atmospheric pressure, moon phase.
 3-Level brightness backlight function. (DC power supply is valid)
 7 Languages of week can be switched. (EN→DE→FR→SP→IT→DU→DA)
 Power Supply: 

Weather Station: Adapter or 2 × LR6 AAA batteries;
Sensor: 2 × LR6 AAA batteries;

 Connection Distance:
Weather  station  and  thermometer&hygrometer  sensor:  100M (No  Distractions/No 
Obstructions)

WEATHER STATION APPEARANCE

1. Air Pressure Data 8. Moon Phase

2. Weather Forecast 9. Indoor Temperature
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3. Time Display 10. Indoor Humidity

4. Alarm Icon 11. Comfort Level

5. DCF Radio Signal 12. Sensor Temperature

6. Month/Date 13. Sensor Humidity

7. Week 14. Low Battery Indicator

A: Power Supply Socket
B: Weather Station Operation Buttons:
MODE: Single press to change the temperature unit °C/°F; Long press to enter setting 
mode, the setting sequence: 12/24 Format → Time Zone → Hour → Minute → Year → 
Month → Date → Date Format(The Order of Month&Date) → Week Language → Exit.
ALARM: Single press to check the alarm time; Long press to enter the alarm setting.
UP:  Single press to check the max&min temperature and humidity data; Long press to 
clear the max&min temperature and humidity data.
DOWN: Single press to ON the ALARM1 and ALARM2; Long press to OFF the ALARM1 
and ALARM2.
RCC: Single press to change the air pressure unit inHg/hPa; Long press for compulsory 
opening or turn off RCC receiving. (RCC means time will be automatically calibrated after 
receiving the signal.)
CH:  Single press to switch the weather station sensor reception channel; Long press to 
clear the weather station transmitter receive channel and re-enter sensor receive mode.

: Powered by battery, single press to turn on the backlight for 10 seconds; Powered 
by  adapter,  single  press  to  adjust  brightness  of  the  backlight,  the  sequence  is 
L3→L2→L1→OFF. When the alarm goes off, single press to enter snooze mode. 
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SENSOR APPEARANCE

1. Outdoor Temperature 6. Sensor Channel Button

2. Sensor Channel 7. Sensor Temperature Unit Button

3. Sensor Wireless Signal 8. Sensor signal Manual Transmission Button

4. Low-electricity Reminder 9. Battery Compartment

5. Outdoor Humidity

Sensor is indoor and outdoor use. However need to be protected against wet, water, rain, 
etc.
NOTE: The channel of the weather station requires consistent with the sensor channel, the 
temperature and humidity data on the sensor can display on the weather station.

QUICK SETUP

 Plug one end of the power adapter into a power outlet, and then plug the other end 
into your weather station. (Optional: Insert 2*AAA batteries as a backup).

 The LCD displays all items for 2 seconds, and then switches to the standard display 
mode  after  a  "beep"  sound  to  display  the  indoor  temperature,  humidity,  and 
atmospheric pressure values.

 Insert 2*AAA batteries into the outdoor thermometer and hygrometer sensor, then 
place it in outdoor place.

 The weather station automatically enters the wireless receiving mode for 3 minutes 
and  automatically  displays  the  outdoor  temperature  and  humidity.  If  the 
thermometer&hygrometer  sensor  not  received  the  data  within  3  minutes  of  the 
weather  station,  weather  station  will  not  automatically  receive  data,  you  need to 
manually operate and receive.

RADIO CONTROL CLOCK INSTRUCTION ( RCC )

NOTE: In the process of RCC receiving the signal, except the backlight can be turned on, 
other functions cannot be operated. If you need to operate the weather station, long press 
the CH button to exit the RCC receiving mode.
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 When weather station is turned on for 3 minutes, it will automatically enter the RCC 

long receiving mode, and the RCC triangular tower symbol " " will display and flash; 
if radio signal is received, the RCC triangular tower symbol " " does not flash, and 
the RCC signal wave symbol " " display and flash; if the radio signal is interrupted 
during  receiving  process,  signal  wave  symbol  " "  of  RCC is  not  displayed,  and 
triangular tower symbol " " of RCC is converted to display and flashes.

 The RCC long reception time is 7 minutes. If the RCC reception is successful within 7 
minutes, the time displayed by the weather station will be converted into the received 
time, and the RCC symbol “ ” will be displayed on the screen; If no signal is received 
within 7 minutes, it will automatically quit RCC reception and continue to travel at the 
original time.

 In the standard mode, long press the  CH button to forcibly enter  RCC reception 
mode, and perform RCC reception in the above-mentioned manner.

 Automatically receive RCC: Regardless of whether the RCC signal is received or not, 
it will automatically enter the RCC reception at 1:00, 2:00, 3:00, 4:00, and 5:00 every 
morning; If the reception is successful at 3:00, the following 4:00 and 5:00 will not be 
opened for reception; no matter whether the reception is successful or not, RCC will 
enter the cycle again at 1:00 in the morning of the next day receive mode.

 In  the  RCC  reception  mode,  the  detection  of  temperature,  temperature  and 
atmospheric pressure is not performed.

 Weather station should be as far away from the device that is relatively large, such 
as: refrigerator, air conditioning, induction cooker, computer.

SETTING TIME MANUALLY 

 Long press the MODE button to enter the time setting mode.
 After entering time setting mode, each time you press the MODE button to confirm 

and enter the next setting item.
 Setting sequence: 12/24 Format → Time Zone → Hour → Minute → Year → Month 

→ Date → Date Format(The Order of Month&Date) → Week Language → Exit.
 Each time you press the "UP" or "DOWN" buttons, the set item will  be added or  

subtracted by one step.
 Long press the "UP" or "DOWN" buttons for more than 3 seconds to quickly increase 

or decrease, 8 steps per second.
 20 seconds without any buttons operation, it will save the setting data and exit setting 

mode.

ALARM SETTING

 Single press ALARM button to check ALARM1 and ALARM2 time.
 Long press the ALARM button to enter the alarm setting mode.
 After entering alarm setting mode, each time you press the ALARM button to confirm 

and enter the next setting item.
 Setting sequence: Hour → Minute → Exit.
 During the setting process, single press the "UP" or "DOWN" button to increase and 

decrease the time. Press and hold for 3 seconds to quickly set the time.
 After alarm setting is completed, the alarm is turned off by default; Press the DOWN 

button once to turn on the ALARM1, press again to turn on the ALARM2, press again 

to turn on the ALARM1 and ALARM2 together; the symbol " " will appear on the 
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screen when turn on the alarm; Long press the DOWN button to turn off the ALARM1 

and ALARM2 together, the alarm symbol " " will disappear.
 20 seconds of no action will save the existing settings and return to the time display, 

or single press the MODE button to exit and return to the time display.
 Alarm sound is divided into 4 segments, 1~10 seconds "Bi" once; 10~ 20 seconds "Bi 

Bi" two beeps; 20~30 seconds "Bi Bi Bi Bi" four beeps; Long beep after 30 seconds.

 When the alarm rings, the alarm signal " " flashes; Alarm time is 2 minutes.

 When the alarm clock rings,  press any buttons except  for  the " "  button to 
cancel the alarm.

SNOOZE FUNCTION 

 When the alarm clock rings, press the " " button, alarm will be delayed for 5 

minutes, and snooze & alarm symbols " " and " " will flash on the screen.

 In  "Snooze"  state,  press  any  buttons  except  for  the  " "  button  to  cancel 
"Snooze".

TEMPERATURE DISPLAY DESCRIPTION

INDOOR TEMPERATURE
Detection Range -9.9°C~5°C (14.0°F~122°F)

Display Resolution 0.1°C (°F)

OUTDOOR TEMPERATURE
Detection Range -40°C~60°C (-40°F~140°F)

Display Resolution 0.1°C (°F)

 Temperature accuracy: 0～40°C: ±1°C, Other range: ±2°C.
 Default  unit  of  temperature:  °C.(If  need to  change unit,  please press  the MODE 

button of weather station to change it.)
 When the  indoor  detection  temperature  is  lower  than  -9.9°C (14.0°F),  the  value 

displayed in the INDOOR TEMPERATURE column will be displayed as "LL.L°C (°F)", 
and  when  the  temperature  is  higher  than  50°C  (122°F),  it  will  be  displayed  as 
"HH.H°C (°F)".

 When  the  outdoor  detection  temperature  is  lower  than  -40°C  (-40°F),  the  value 
displayed in the OUTDOOR TEMPERATURE column will be displayed as "LL.L°C 
(°F)", and when the temperature is higher than 60°C (140°F), it will be displayed as 
"HH.H°C (°F)".

HUMIDITY DISPLAY DESCRIPTION

INDOOR HUMIDITY
Detection Range 20%RH~95%RH

Display Resolution 1%RH

OUTDOOR HUMIDITY
Detection Range 20%RH~95%RH

Display Resolution 1%RH

 Humidity accuracy: 40%RH～80%RH: ±5%RH, Other range: ±8%RH.
 If  the  detected  indoor  or  outdoor  humidity  is  lower  than  20%RH,  it  will  still  be 

displayed as "20%RH", and if it is higher than 95%RH, it will still be displayed as 
"95%RH".
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MAX/MIN TEMPERATURE&HUMIDITY

 Press once UP button to display the MAX temperature and humidity record, press 
again to display the MIN temperature&humidity record, press again to exit.

 Long press UP button to clear the record of MAX/MIN temperature and humidity; 
temperature displays "--.-" for 3 seconds, and then return to the current temperature 
display.

 After clearing the record, start to record the new MAX/MIN temperature and humidity.
 MAX/MIN records the highest and lowest temperature&humidity of the day, which is 

automatically cleared and re-recorded at 0:00 every day.
 When MAX or MIN is displayed, if there is no operation for 20 seconds, it will return 

to the current temperature display

TEMPERATURE&HUMIDITY TREND DESCRIPTION 

 When the temperature continues to increase by 1°C (1.8°F) or more, the temperature 
trend symbol " " will be displayed.

 When the temperature does not change more than 1°C (1.8°F) within 1 hour, the 
degree trend symbol " " will be displayed.

 When the temperature continues to drop by 1°C (1.8°F) or more, the temperature 
trend symbol " " will be displayed.

 When the humidity continues to rise by 5%RH and above, temperature trend symbol 
" " will be displayed.

 When the humidity does not change more than 5%RH within 1 hour, the degree trend 
symbol " " will be displayed.

 When the humidity continues to drop by 5%RH or more, temperature trend symbol "
" will be displayed.

TYPES OF WEATHER DISPLAYED 

The weather forecast is to predict the weather in the next 12 hours according to the air 
pressure changes in the past and reality; Calculate and prediction every past 6 hours; 5 
types of weather prediction as shown below

Sunny

Partly Cloudy

Cloudy

Light Rain

Heavy Rain
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MOON PHASE INSTRUCTION

The moon phase level is displayed in the MOON PHASE column. The moon phase level is 
divided into 8 levels, as shown in the figure below:

New Moon → Crescent Moon → First Quarter Moon → Waning Gibbous Moon → Full 
Moon → Waning Gibbous Moon → Last Quarter Moon → Waning Moon

ATMOSPHERIC PRESSURE INSTRUCTION

Switch the air pressure unit in the setting mode.The atmospheric pressure is updated and 
tested every 1 hour, and the air pressure value is recorded at the same time.(Air pressure 
default unit: hPa; if need to change unit, please press the RCC button of weather station.)

ATMOSPHERIC 
PRESSURE

DETECTION RANGE
600 hPa/mb~1100 hPa/mb
(17.72 inHg~32.50 inHg)

DISPLAY RESOLUTION 1 hPa/mb & 0.01 inHg

LOW BATTERY INDICATOR 

 When the operating voltage of the weather station is lower than 2.5V, the low-battery 
symbol " " will be displayed, indicating that the battery needs to be replaced. 

 When  the  working  voltage  of  the  transmitter  is  lower  than  2.5V,  the  low-battery 
warning signal will be issued, and the low battery symbol " " will be displayed in 
the corresponding channel column. 

BACKLIGHT SETTING

 When weather station is powered by batteries, press " "  button once in any 

mode to turn on the backlight for 10s, backlight will turn off automatically if the "
" button is not pressed during the lighting process.

 When the weather station is powered by DC-POWER (after it  is powered by DC-
POWER, the circuit will automatically disconnect if the product has a battery), the 

backlight  will  stay  on,  press  the  " "  button  to  switch  the  brightness  of  the 
backlight. And the brightness is divided into 3 degrees: L3→L2→L1→Off.

NOTE: When the weather station is powered by DC-POWER, if it enters RCC reception 
automatically or manually, the backlight will be automatically turned off. You can press the 

" " button to turn on the backlight for 10 seconds (the brightest mode).

WEATHER STATION CHANNEL

 If the weather station is receiving the outdoor sensor radio signal, it will automatically 
display the appropriate channel. However, you can also manually set the display of 
the various radio channels.

 Press button CH repeatedly to toggle between the displays  (show only channel 1), 

(show  only  channel  2),  (show  only  channel  3)  and   (scroll  through  all 
channels in a loop).
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 If  the sensor does not automatically connect to the weather station, please try to 
connect manually; Long press the CH button to clear the weather station transmitter 
receive channel and re-enter receive mode.

SENSOR CHANNEL 

 Open the battery compartment on the rear of the appliance by removing the battery 
compartment cover.

 Select a radio channel by pushing the channel selector switch CH to CH 1, CH 2 or 
CH 3.

 Press and hold the weather station button CH until the reception signal " " flashes 
on the outdoor display.

 Press the TX button to manually initiate the outdoor sensor radio signal. If reception 
is successful, the temperature and humidity will  now be displayed on the outdoor 
display on the new radio channel.

FREQUENTLY ASKED QUESTIONS

Q1. Why is the time automatic calibration incorrect ?
A1: DCF Atomic Clock:
The signal of clock is DCF, signal received by DCF is the German time. If your local time 
the same as German time, you don't need to adjust ZONE. If your local time is 1 hour 
behind Germany, you need to adjust the ZONE time to -01; if your local time is 1 hour 
ahead of Germany, you need to adjust the ZONE time to 01.For example, the UK time is 1 
hour behind the German time, the ZONE should be adjusted to -01. (If need to change 
time ZONE, please refer to the SET button of weather station to change it)

Q2. Why is the weather station does not immediately display the data of the outdoor 
sensor after powered?
A2: The thermometer&hygrometer sensor have a signal transmission cycle, transmission 
cycle is as follows: Sensor: CH1: 50 seconds; CH2: 63 seconds; CH3: 76 seconds. 

Q3.Why is the backlight suddenly extinguished and the weather station cannot be 
operated?
A3: During the reception,  triangle  symbol  " "  is  flashing,  no other  operations can be 
performed. It takes about 4-8 minutes to complete the reception. If need to operate, long 
press CH button to exit the signal reception, triangle symbol no longer flashes, you can 
operate the clock now.

Q4.Why the outdoor sensor data do not displayed on the screen of the weather 
station?
A4: First, please check whether the temperature and humidity sensor channel is the same 
as the channel of the weather station, For example, the weather station channel is 1, and 
the sensor channel needs to be 1; Second, please check whether the distance between 
the weather station and the transmitter is more than our distance range.
Noted: After power on, the weather station will turn on the 3 minute receiving mode. If the 
thermometer&hygrometer  sensor  not  received within 3 minutes of  the weather  station, 
weather station will  not  automatically  receive data,  you need to manually  operate and 
receive. (For specific operation methods, please refer to A5)

Q5.What should be done if the thermometer&hygrometer sensor not connected with 
the weather station?
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A5: Long press  the  CH button  on  the  weather  station  for  more  than 3  seconds,  the 
receiving icon of temperature & humidity " " will be flashed in the weather station, and 
then open the battery cover of the sensor and press the TX button to manual connection 
(Please refer to the A3 before operation) or re-power the weather station.

Disposal of electrical equipment

The symbol  of  the  crossed-out  wheeled  waste  container  placed  on  the 
products informs that used electrical and electronic equipment (hereinafter 
also "waste equipment" or "electro-waste")  may not be disposed of  with 
municipal waste. By throwing e-waste into the container, you pose a threat 
to the environment. Used equipment may contain substances (e.g. lead, 
cadmium,  chromium,  bromine,  mercury,  freon)  that  are  dangerous  to 

human  health  and  life  and  to  the  environment.  By  sorting  and  handing  over  used 
equipment for processing, recovery, recycling and disposal, you protect the environment 
against  pollution  and  contamination,  you  contribute  to  reducing  the  use  of  natural 
resources and lowering the production costs of new equipment.

CE declaration

Malis B. Machoński sp. k. Declares that the Maltec device Daily2000M Wireless Weather 
Station meets all the requirements of the LVD Directive 2014/35/EU, EC 2014/30/EU and 
meets the following standards:
EN IEC 62368-1:2020+A11:2020
EN 62479: 2010 EN 50663: 2017
EN 301 489-1 V2.2.3 (2019-11)
EN 301 489-3 V2.3.2 (2023-01)

EN 55032: 2015+A11:2020
EN 55035: 2017+A11:2020
EN 61000-3-3:2013+A1:2019
EN 300 220-1 V3.1.1 (2017-02)
EN 300 220-2 V3.2.1 (2018-06)

Importer:

Malis B. Machoński sp. k.
ul. Zbożowa 2E, Wysogotowo
62-081 Przeźmierowo
www.maltec.pl
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Drahtlose Wetterstation Daily2000M

Bedienungsanleitung



Bitte lesen Sie diese Broschüre vor der Verwendung gründlich durch 
und bewahren Sie sie zum späteren Nachschlagen auf.

FUNKTIONEN

 Wettervorhersage.  (Sonnig,  teilweise  bewölkt,  bewölkt,  leichter  Regen,  starker 
Regen)

 Automatische Zeitkalibrierung. (DCF)
 12/24-Stunden-Anzeige für Uhrzeit/Monat/Tag/Woche.
 Wecker und Schlummerfunktion.
 Innen-  und  Außentemperatur  und  Luftfeuchtigkeit,  °C  bis  °F  umschaltbar.  (Die 

Wetterstation  kann  gleichzeitig  mit  drei  Temperatur-  und  Feuchtigkeitssensoren 
gekoppelt werden.)

 Aufzeichnung von Max./Min.-Temperatur und Luftfeuchtigkeit.
 Anzeige von Trendänderungen bei  Temperatur und Luftfeuchtigkeit  im Innen- und 

Außenbereich.
 Komfortindikator für die Luftfeuchtigkeit im Innenbereich.
 Luftdruck, Mondphase.
 Hintergrundbeleuchtungsfunktion mit  3-stufiger  Helligkeit.  (DC-Stromversorgung ist 

gültig)
 7 Wochensprachen umschaltbar. (EN→DE→FR→SP→IT→DU→DA)
 Stromversorgung:

Wetterstation: Adapter oder 2 × LR6 AAA-Batterien;
Sensor: 2 × LR6 AAA-Batterien;

 Verbindungsentfernung:
Wetterstation  und  Thermometer-  und  Hygrometersensor:  100 m  (keine 
Ablenkungen/keine Hindernisse)

AUSSEHEN DER WETTERSTATION
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1. Luftdruckdaten 8. Mond Phase

2. Wettervorhersage 9. Innentemperatur

3. Zeitanzeige 10. Luftfeuchtigkeit im Innenbereich

4. Alarmsymbol 11. Komfortniveau

5. DCF-Funksignal 12. Sensortemperatur

6. Monatsdatum 13. Sensorfeuchtigkeit

7. Woche 14. Anzeige für niedrigen Batteriestand

A: Netzteilbuchse
B: Bedientasten der Wetterstation:
MODUS: Einmal drücken, um die Temperatureinheit °C/°F zu ändern; Lange drücken, um 
in  den  Einstellungsmodus  zu  gelangen,  die  Einstellungsreihenfolge:  12/24-Format  → 
Zeitzone  →  Stunde  →  Minute  →  Jahr  →  Monat  →  Datum  →  Datumsformat  (die 
Reihenfolge von Monat und Datum) → Wochensprache → Beenden.
ALARM:  Einmal  drücken,  um  die  Weckzeit  zu  prüfen;  lange  drücken,  um  die 
Weckeinstellung aufzurufen.
NACH  OBEN:  Einmal  drücken,  um  die  maximalen  und  minimalen  Temperatur-  und 
Feuchtigkeitsdaten  zu  prüfen;  Lange  drücken,  um  die  maximalen  und  minimalen 
Temperatur- und Feuchtigkeitsdaten zu löschen.
NACH UNTEN:  Einmal drücken, um ALARM1 und ALARM2 EINZUSCHALTEN; Lange 
drücken, um ALARM1 und ALARM2 AUSZUSCHALTEN.
RCC: Einmal drücken, um die Luftdruckeinheit in Hg/hPa zu ändern; Lange drücken, um 
den RCC-Empfang zwangsweise zu öffnen oder auszuschalten. (RCC bedeutet, dass die 
Zeit nach Empfang des Signals automatisch kalibriert wird.)
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CH:  Einmal drücken, um den Empfangskanal des Wetterstationssensors umzuschalten; 
lange drücken, um den Empfangskanal des Wetterstationssenders zu löschen und erneut 
in den Sensor-Empfangsmodus zu wechseln.

: Batteriebetrieben, einmaliges Drücken schaltet die Hintergrundbeleuchtung für 10 
Sekunden ein; Stromversorgung über Adapter, einmaliges Drücken regelt die Helligkeit der 
Hintergrundbeleuchtung, die Reihenfolge ist L3→L2→L1→AUS. Wenn der Alarm losgeht, 
einmaliges Drücken ruft den Schlummermodus auf.

AUSSEHEN DES SENSORS

1. Außentemperatur 6. Sensorkanal-Taste

2. Sensorkanal 7. Sensor Temperatur Einheit Taste

3. Sensor-Funksignal 8. Sensorsignal Schaltgetriebetaste

4. Erinnerung bei niedrigem 
Stromverbrauch

9. Batteriefach

5. Luftfeuchtigkeit im Freien

Der  Sensor  ist  für  den  Innen-  und  Außenbereich  geeignet.  Muss  jedoch  vor  Nässe, 
Wasser, Regen usw. geschützt werden.
HINWEIS: Der Kanal der Wetterstation muss mit dem Sensorkanal übereinstimmen, damit 
die  Temperatur-  und  Feuchtigkeitsdaten  des  Sensors  auf  der  Wetterstation  angezeigt 
werden können.

SCHNELLES SETUP

 Stecken Sie ein Ende des Netzteils in eine Steckdose und das andere Ende in Ihre 
Wetterstation. (Optional: Legen Sie als Ersatz 2 AAA-Batterien ein).

 Das LCD zeigt alle Elemente 2 Sekunden lang an und wechselt dann nach einem 
Piepton  in  den  Standardanzeigemodus,  um  die  Werte  für  Innentemperatur, 
Luftfeuchtigkeit und Luftdruck anzuzeigen.

 Legen Sie 2 AAA-Batterien in den Außenthermometer- und Hygrometersensor ein 
und platzieren Sie ihn anschließend im Freien.

 Die  Wetterstation  wechselt  automatisch  für  3  Minuten  in  den  drahtlosen 
Empfangsmodus und zeigt automatisch die Außentemperatur und Luftfeuchtigkeit an. 
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Wenn der  Thermometer-  und Hygrometersensor  die  Daten nicht  innerhalb  von 3 
Minuten von der Wetterstation empfängt, empfängt die Wetterstation die Daten nicht 
automatisch. Sie müssen sie manuell bedienen und empfangen.

Anleitung für Funkuhren (RCC)

HINWEIS:  Während  RCC  das  Signal  empfängt,  können  außer  der  Einschaltung  der 
Hintergrundbeleuchtung  keine  anderen  Funktionen  ausgeführt  werden.  Wenn  Sie  die 
Wetterstation  bedienen  müssen,  drücken  Sie  lange  auf  die  Taste  CH,  um den  RCC-
Empfangsmodus zu verlassen.
 Wenn die Wetterstation 3 Minuten lang eingeschaltet ist, wechselt sie automatisch in 

den  RCC-Langzeitempfangsmodus  und  das  RCC-Dreiecksturmsymbol  „  “  wird 
angezeigt  und  blinkt.  Wenn  ein  Funksignal  empfangen  wird,  blinkt  das  RCC-
Dreiecksturmsymbol „ “ nicht und das RCC-Signalwellensymbol „  “ wird angezeigt 
und  blinkt.  Wenn  das  Funksignal  während  des  Empfangsvorgangs  unterbrochen 
wird,  wird  das Signalwellensymbol  „  “  von RCC nicht  angezeigt  und das RCC-
Dreiecksturmsymbol „ “ wird angezeigt und blinkt.

 Die RCC-Langempfangszeit beträgt 7 Minuten. Wenn der RCC-Empfang innerhalb 
von 7 Minuten erfolgreich ist, wird die von der Wetterstation angezeigte Zeit in die 
empfangene Zeit umgerechnet und das RCC-Symbol „  “ wird auf dem Bildschirm 
angezeigt.  Wenn innerhalb  von 7  Minuten  kein  Signal  empfangen wird,  wird  der 
RCC-Empfang  automatisch  beendet  und  die  Fahrt  wird  zur  ursprünglichen  Zeit 
fortgesetzt.

 Drücken Sie im Standardmodus lange die Taste CH , um den RCC-Empfangsmodus 
zwangsweise  aufzurufen,  und  führen  Sie  den  RCC-Empfang  in  der  oben 
beschriebenen Weise durch.

 RCC automatisch empfangen: Unabhängig davon, ob das RCC-Signal empfangen 
wird oder nicht, wird der RCC-Empfang jeden Morgen um 1:00, 2:00, 3:00, 4:00 und 
5:00  Uhr  automatisch  aktiviert.  Wenn  der  Empfang  um  3:00  Uhr  erfolgreich  ist, 
werden die folgenden 4:00 und 5:00 Uhr nicht für den Empfang geöffnet. Unabhängig 
davon, ob der Empfang erfolgreich ist oder nicht, wird RCC am nächsten Tag um 
1:00 Uhr morgens erneut in den Empfangszyklus aktiviert.

 Im  RCC-Empfangsmodus  wird  die  Erkennung  von  Temperatur,  Temperatur  und 
Luftdruck nicht durchgeführt.

 Die  Wetterstation  sollte  möglichst  weit  entfernt  von  größeren  Geräten  wie 
beispielsweise  Kühlschränken,  Klimaanlagen,  Induktionsherden  oder  Computern 
aufgestellt werden.

MANUELLE ZEITEINSTELLUNG

 Drücken Sie lange die MODE-Taste, um in den Zeiteinstellungsmodus zu gelangen.
 Nachdem Sie den Zeiteinstellungsmodus aufgerufen haben, drücken Sie jedes Mal 

die  MODE-Taste,  um  zu  bestätigen  und  zum  nächsten  Einstellungselement  zu 
gelangen.

 Einstellungsreihenfolge: 12/24-Format → Zeitzone → Stunde → Minute → Jahr → 
Monat  →  Datum  →  Datumsformat  (Reihenfolge  von  Monat  und  Datum)  → 
Wochensprache → Beenden.

 Bei jedem Drücken der Tasten „UP“ oder „DOWN“ wird der eingestellte Wert  um 
einen Schritt addiert oder subtrahiert.

 Drücken Sie die Tasten „UP“ oder „DOWN“ länger als 3 Sekunden, um den Wert 
schnell um 8 Schritte pro Sekunde zu erhöhen oder zu verringern.
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 Nach 20 Sekunden ohne Tastenbetätigung werden die Einstellungsdaten gespeichert 
und der Einstellungsmodus verlassen.

ALARMEINSTELLUNG

 die ALARM- Taste einmal, um die ALARM1- und ALARM2-Zeit zu überprüfen.
 Drücken Sie lange die ALARM- Taste, um in den Alarmeinstellmodus zu gelangen.
 Nachdem Sie den Alarmeinstellmodus aufgerufen haben, drücken Sie jedes Mal die 

ALARM-  Taste,  um  zu  bestätigen  und  zum  nächsten  Einstellungselement  zu 
gelangen.

 Einstellreihenfolge: Stunde → Minute → Ende.
 Drücken Sie während des Einstellvorgangs einmal die Taste „ UP “ oder „ DOWN “, 

um die Zeit zu erhöhen bzw. zu verringern. Zum schnellen Einstellen der Uhrzeit 3 
Sekunden lang gedrückt halten.

 Nachdem  die  Alarmeinstellung  abgeschlossen  ist,  ist  der  Alarm  standardmäßig 
ausgeschaltet.  Drücken Sie die Taste  DOWN  einmal,  um ALARM1 einzuschalten, 
drücken Sie erneut, um ALARM2 einzuschalten, drücken Sie erneut, um ALARM1 

und  ALARM2  gleichzeitig  einzuschalten.  Beim  Einschalten  des  Alarms 
erscheint das Symbol „ “ auf dem Bildschirm. Drücken Sie lange die Taste DOWN , 

um ALARM1 und ALARM2 gleichzeitig  auszuschalten.  Das Alarmsymbol  „  “ 
verschwindet.

 Wenn  Sie  20  Sekunden  lang  keine  Aktion  ausführen,  werden  die  vorhandenen 
Einstellungen gespeichert und Sie kehren zur Zeitanzeige zurück. Alternativ können 
Sie  zum  Beenden  und  Zurückkehren  zur  Zeitanzeige  einmal  die  MODE-  Taste 
drücken.

 Der  Alarmton  ist  in  vier  Abschnitte  unterteilt:  1–10  Sekunden einmal  „Bi“,  10–20 
Sekunden zwei Pieptöne „Bi Bi“, 20–30 Sekunden vier Pieptöne „Bi Bi Bi Bi“, langer 
Piepton nach 30 Sekunden.

 Wenn  der  Alarm  ertönt,  blinkt  das  Alarmsignal  „  “;  die  Alarmzeit  beträgt  2 
Minuten.

 Wenn der Wecker klingelt, drücken Sie eine beliebige Taste außer der  Taste 
„ “, um den Alarm abzubrechen.

SNOOZE-FUNKTION

 Wenn der Wecker klingelt,  drücken Sie die  Taste „  “.  Der Alarm wird um 5 

Minuten verzögert und die Schlummer- und Alarmsymbole „ “ und „ “ blinken 
auf dem Bildschirm.

 Drücken Sie im „Snooze“-Zustand eine beliebige Taste außer der „ “-Taste, um 
die „Snooze“-Funktion abzubrechen.

TEMPERATURANZEIGE BESCHREIBUNG

INNENTEMPERATUR
Erfassungsbereich

-9,9 °C bis 5 °C (14,0 °F bis 
122 °F)

Bildschirmauflösung 0,1 °C (°F)

AUSSENTEMPERATUR
Erfassungsbereich

-40 °C bis 60 °C (-40 °F bis 
140 °F)

Bildschirmauflösung 0,1 °C (°F)
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 Temperaturgenauigkeit: 0–40 °C: ±1 °C, anderer Bereich: ±2 °C.
 Standardtemperatureinheit: °C. (Wenn Sie die Einheit ändern müssen, drücken Sie 

zum Ändern bitte die MODE-Taste der Wetterstation.)
 Wenn die  erkannte  Innentemperatur  unter  -9,9 °C (14,0 °F)  liegt,  wird  der  in  der 

Spalte INNENTEMPERATUR angezeigte Wert als „LL.L°C (°F)“ angezeigt, und wenn 
die Temperatur über 50 °C (122 °F) liegt, wird er als „HH.H°C (°F)“ angezeigt.

 Wenn die  erkannte  Außentemperatur  unter  -40 °C (-40 °F)  liegt,  wird  der  in  der 
Spalte „AUSSENTEMPERATUR“ angezeigte Wert als „LL.L °C (°F)“ angezeigt, und 
wenn die Temperatur über 60 °C (140 °F) liegt, wird er als „HH.H °C (°F)“ angezeigt.

FEUCHTIGKEITSANZEIGE BESCHREIBUNG

LUFTFEUCHTIGKEIT IM 
INNENRAUM

Erfassungsbereich
20 % relative Luftfeuchtigkeit 

bis 95 % relative 
Luftfeuchtigkeit

Bildschirmauflösung 1 % relative Luftfeuchtigkeit

LUFTFEUCHTIGKEIT IM 
AUSSENBEREICH

Erfassungsbereich
20 % relative Luftfeuchtigkeit 

bis 95 % relative 
Luftfeuchtigkeit

Bildschirmauflösung 1 % relative Luftfeuchtigkeit

 Feuchtigkeitsgenauigkeit: 40 % RH – 80 % RH: ± 5 % RH, anderer Bereich: ± 8 % 
RH.

 Wenn die erkannte Luftfeuchtigkeit im Innen- oder Außenbereich unter 20 % relativer 
Luftfeuchtigkeit liegt, wird sie dennoch als „20 % relativer Luftfeuchtigkeit“ angezeigt, 
und wenn sie über 95 % relativer Luftfeuchtigkeit liegt, wird sie dennoch als „95 % 
relativer Luftfeuchtigkeit“ angezeigt.

MAXIMALE/MINIMALE TEMPERATUR UND FEUCHTIGKEIT

 Drücken  Sie  einmal  die  Taste  „UP“,  um  die  maximalen  Temperatur-  und 
Feuchtigkeitsdaten anzuzeigen, drücken Sie erneut, um die minimalen Temperatur- 
und Feuchtigkeitsdaten anzuzeigen, und drücken Sie erneut, um zu beenden.

 Drücken Sie  lange die  Taste UP,  um die  Aufzeichnung der  maximalen/minimalen 
Temperatur und Luftfeuchtigkeit  zu löschen. Bei der Temperatur wird 3 Sekunden 
lang „--.-“ angezeigt, dann kehrt man zur aktuellen Temperaturanzeige zurück.

 Beginnen Sie nach dem Löschen des Datensatzes mit der Aufzeichnung der neuen 
Maximal-/Minimaltemperatur und -feuchtigkeit.

 MAX/MIN zeichnet die höchste und niedrigste Temperatur und Luftfeuchtigkeit des 
Tages auf, die jeden Tag um 0:00 Uhr automatisch gelöscht und neu aufgezeichnet 
werden.

 Wenn MAX oder MIN angezeigt wird und 20 Sekunden lang keine Bedienung erfolgt, 
wird zur aktuellen Temperaturanzeige zurückgekehrt

BESCHREIBUNG DES TEMPERATUR- UND FEUCHTIGKEITSTRENDS

 wird das Temperaturtrendsymbol „ “ angezeigt.
 wird das Gradtrendsymbol „ “ angezeigt.
 wird das Temperaturtrendsymbol „ “ angezeigt.
 wird das Temperaturtrendsymbol „ “ angezeigt.
 wird das Gradtrendsymbol „ “ angezeigt.
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 wird das Temperaturtrendsymbol „ “ angezeigt.

Angezeigte Wetterarten

Die Wettervorhersage soll  das Wetter  in den nächsten 12 Stunden auf  Grundlage der 
Luftdruckänderungen in der Vergangenheit und der Realität vorhersagen. Alle letzten 6 
Stunden berechnen und vorhersagen. 5 Arten der Wettervorhersage, wie unten dargestellt

Sonnig

Teilweise bewölkt

Wolkig

Leichter Regen

Starkregen

MONDPHASENANLEITUNG

Die  Mondphasenebene  wird  in  der  Spalte  MONDPHASE  angezeigt.  Die 
Mondphasenebene ist in 8 Ebenen unterteilt, wie in der folgenden Abbildung dargestellt:

Neumond → Halbmond → Erstes Viertel des Mondes → Abnehmender Dreiviertelmond → 
Vollmond  →  Abnehmender  Dreiviertelmond  →  Letztes  Viertel  des  Mondes  → 
Abnehmender Mond

ANLEITUNG ZUM ATMOSPHÄRISCHEN DRUCK

Wechseln  Sie  im  Einstellmodus  die  Luftdruckeinheit.  Der  Luftdruck  wird  jede  Stunde 
aktualisiert und geprüft und gleichzeitig der Luftdruckwert aufgezeichnet. (Standardeinheit 
für Luftdruck: hPa; wenn Sie die Einheit ändern möchten, drücken Sie bitte die RCC- Taste 
der Wetterstation.)

LUFTDRUCK
ERFASSUNGSBEREICH

600 hPa/mb~1100 hPa/mb
(17,72 ZollHg bis 32,50 

ZollHg)

BILDSCHIRMAUFLÖSUNG 1 hPa/mb und 0,01 inHg

ANZEIGE FÜR NIEDRIGEN BATTERIESTAND

 Wenn die Betriebsspannung der Wetterstation unter 2,5 V liegt, wird das Symbol 
für  niedrigen  Batteriestand  „  “  angezeigt,  um  anzuzeigen,  dass  die  Batterie 
ausgetauscht werden muss.
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 Wenn die Betriebsspannung des Senders unter 2,5 V liegt, wird das Warnsignal für 
niedrigen Batteriestand ausgegeben und das Symbol für niedrigen Batteriestand „ 

“ in der entsprechenden Kanalspalte angezeigt.

HINTERGRUNDBELEUCHTUNGSEINSTELLUNG

 Wenn die  Wetterstation mit  Batterien betrieben wird,  drücken Sie  in  einem 
beliebigen  Modus  einmal  die  Taste  „  “,  um  die  Hintergrundbeleuchtung  für  10 
Sekunden einzuschalten. Die Hintergrundbeleuchtung schaltet sich automatisch aus, 

wenn die Taste „ “ während des Beleuchtungsvorgangs nicht gedrückt wird.
 Wenn die Wetterstation über Gleichstrom mit Strom versorgt wird (nachdem sie über 

Gleichstrom mit Strom versorgt wird, wird der Stromkreis automatisch getrennt, wenn 
das  Produkt  über  eine  Batterie  verfügt),  bleibt  die  Hintergrundbeleuchtung 

eingeschaltet.  Drücken  Sie  die  Taste  „  “,  um  die  Helligkeit  der 
Hintergrundbeleuchtung umzuschalten. Und die Helligkeit ist in 3 Stufen unterteilt: 
L3→L2→L1→Aus.

HINWEIS:  Wenn  die  Wetterstation  über  DC-POWER  mit  Strom  versorgt  wird  und 
automatisch  oder  manuell  in  den  RCC-Empfang  wechselt,  wird  die 

Hintergrundbeleuchtung  automatisch  ausgeschaltet.  Sie  können  die  Taste  „  “ 
drücken, um die Hintergrundbeleuchtung für 10 Sekunden einzuschalten (hellster Modus).

WETTERSTATION-KANAL

 Empfängt die Wetterstation das Funksignal des Außensensors, zeigt sie automatisch 
den  entsprechenden  Kanal  an.  Sie  können  die  Anzeige  der  verschiedenen 
Radiosender jedoch auch manuell einstellen.

 Drücken der Taste CH können Sie zwischen den Anzeigen (nur Kanal 1 anzeigen), 

(nur Kanal 2 anzeigen),  (nur Kanal 3 anzeigen) und  (alle Kanäle in einer 
Schleife durchblättern) wechseln.

 Wenn  der  Sensor  nicht  automatisch  eine  Verbindung  zur  Wetterstation  herstellt, 
versuchen Sie  bitte,  die  Verbindung manuell  herzustellen.  Drücken Sie  lange die 
Taste  CH , um den Empfangskanal des Senders der Wetterstation zu löschen und 
erneut in den Empfangsmodus zu wechseln.

SENSORKANAL

 Öffnen  Sie  das  Batteriefach  auf  der  Rückseite  des  Gerätes,  indem  Sie  den 
Batteriefachdeckel abnehmen.

 Wählen Sie einen Radiokanal, indem Sie den Kanalwahlschalter CH auf CH 1, CH 2 
oder CH 3 schieben.

 CH  der Wetterstation gedrückt, bis auf der Außenanzeige das Empfangssignal „ “ 
blinkt.

 Drücken  Sie  die  TX-  Taste,  um  das  Funksignal  des  Außensensors  manuell  zu 
starten. Bei erfolgreichem Empfang werden nun Temperatur und Luftfeuchtigkeit auf 
dem Außendisplay auf dem neuen Funkkanal angezeigt.

HÄUFIG GESTELLTE FRAGEN

Frage 1. Warum ist die automatische Zeitkalibrierung falsch?
A1: DCF-Atomuhr:
Das Uhrsignal ist DCF, das von DCF empfangene Signal ist die deutsche Zeit. Wenn Ihre 
Ortszeit  mit  der deutschen Zeit  übereinstimmt,  müssen Sie die ZONE nicht  anpassen. 
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Wenn Ihre Ortszeit 1 Stunde hinter der deutschen liegt, müssen Sie die ZONE-Zeit auf -01 
einstellen; wenn Ihre Ortszeit 1 Stunde vor der deutschen liegt, müssen Sie die ZONE-Zeit 
auf 01 einstellen. Wenn beispielsweise die britische Zeit 1 Stunde hinter der deutschen 
Zeit  liegt,  sollte die ZONE auf  -01 eingestellt  werden.  (Wenn Sie die Zeitzone ändern 
müssen, verwenden Sie zum Ändern bitte die SET-Taste der Wetterstation.)

Frage 2. Warum zeigt die Wetterstation nach dem Einschalten nicht sofort die Daten 
des Außensensors an?
A2:  Der  Thermometer-  und  Hygrometersensor  verfügt  über  einen 
Signalübertragungszyklus,  der  wie  folgt  ist:  Sensor:  CH1:  50  Sekunden;  CH2:  63 
Sekunden; CH3: 76 Sekunden.

F3. Warum erlischt die Hintergrundbeleuchtung plötzlich und die Wetterstation kann 
nicht bedient werden?
A3: Während des Empfangs  blinkt  das Dreiecksymbol  „  “,  es können keine anderen 
Vorgänge  ausgeführt  werden.  Der  Empfang  dauert  etwa  4–8  Minuten.  Wenn  eine 
Bedienung erforderlich ist, drücken Sie lange auf die CH-Taste, um den Signalempfang zu 
beenden. Das Dreiecksymbol blinkt nicht mehr und Sie können die Uhr jetzt bedienen.

F4.  Warum  werden  die  Daten  des  Außensensors  nicht  auf  dem  Bildschirm  der 
Wetterstation angezeigt?
A4: Überprüfen Sie zunächst, ob der Kanal des Temperatur- und Feuchtigkeitssensors mit 
dem Kanal der Wetterstation übereinstimmt. Beispiel: Der Kanal der Wetterstation ist 1 
und der Sensorkanal muss 1 sein. Überprüfen Sie zweitens, ob die Entfernung zwischen 
der Wetterstation und dem Sender größer ist als unser Entfernungsbereich.
Hinweis:  Nach  dem  Einschalten  schaltet  die  Wetterstation  in  den  3-Minuten-
Empfangsmodus.  Wenn  der  Thermometer-  und  Hygrometersensor  innerhalb  von  3 
Minuten keine Daten von der Wetterstation empfängt, empfängt die Wetterstation diese 
nicht  automatisch.  Sie  müssen  sie  manuell  bedienen  und  empfangen.  (Spezifische 
Bedienungsmethoden finden Sie unter A5 .)

F5. Was ist zu tun, wenn der Thermometer- und Hygrometersensor nicht mit der 
Wetterstation verbunden ist?
A5: Halten Sie die CH- Taste an der Wetterstation länger als 3 Sekunden gedrückt. Das 
Empfangssymbol  für  Temperatur  und  Luftfeuchtigkeit  „  “  blinkt  in  der  Wetterstation. 
Öffnen Sie dann die Batterieabdeckung des Sensors und drücken Sie die TX- Taste, um 
eine manuelle Verbindung herzustellen (siehe vor dem Betrieb bitte A3) oder schalten Sie 
die Wetterstation wieder ein.

Entsorgung von Elektrogeräten

Das  auf  den  Produkten  angebrachte  Symbol  der  durchgestrichenen 
Mülltonne weist darauf hin, dass verbrauchte elektrische und elektronische 
Geräte (nachfolgend auch „Altgeräte“ oder „Elektroschrott“) nicht über den 
Hausmüll  entsorgt  werden  dürfen.  Indem  Sie  Elektroschrott  in  den 
Container werfen, gefährden Sie die Umwelt. Altgeräte können Stoffe (z. B. 
Blei,  Cadmium,  Chrom,  Brom,  Quecksilber,  Freon)  enthalten,  die  eine 

Gefahr für die menschliche Gesundheit und das Leben sowie für die Umwelt darstellen. 
Durch  die  Sortierung und Übergabe von Altgeräten  zur  Aufbereitung,  Rückgewinnung, 
Wiederverwertung  und  Entsorgung  schützen  Sie  die  Umwelt  vor  Verschmutzung  und 
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Verunreinigung,  tragen zur  Schonung der  natürlichen Ressourcen bei  und senken die 
Produktionskosten neuer Geräte.

CE-Erklärung

Malis B. Machoński sp. k. Erklärt, dass das Maltec-Gerät Daily2000M Wireless Weather 
Station alle Anforderungen der LVD-Richtlinie 2014/35/EU, EG 2014/30/EU erfüllt und die 
folgenden Normen erfüllt:
EN IEC 62368-1:2020+A11:2020
EN 62479: 2010 EN 50663: 2017
EN 301 489-1 V2.2.3 (2019-11)
EN 301 489-3 V2.3.2 (2023-01)

EN 55032: 2015+A11:2020
EN 55035: 2017+A11:2020
EN 61000-3-3:2013+A1:2019
EN 300 220-1 V3.1.1 (2017-02)
EN 300 220-2 V3.2.1 (2018-06)

Importeur:

Malis B. Machoński sp. k.
ul. Zbożowa 2E, Wysogotowo
62-081 Przeźmierowo
www.maltec.pl
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